inView 360 HD
Around Vehicle Monitoring System

Calibration Guide
Contents

Introduction to Calibration ......................................................................................................................... 3
Calibration Kit Components .......................................................................................................................... 3
Placing Calibration Pads .............................................................................................................................. 3
Verifying Calibration Pad Placement ........................................................................................................... 4
Before You Begin Calibrating ..................................................................................................................... 7
  Preparing the Calibration Tool ................................................................................................................... 7
  Transferring Image Files from the inView 360 HD System to Your Computer ........................................... 7
    1) Export the inView 360 HD AVM Video Files / Logging in to the Calibration Tool ................................. 7
    2) Transfer the Image Files to the PC ........................................................................................................ 12
    3) Load the Images into the Calibration Tool ............................................................................................ 12
Calibrating the inView 360 HD ..................................................................................................................... 15
  The Calibration Process ............................................................................................................................ 15
    Marking the Calibration Points .................................................................................................................. 15
    Calibrating the Calibration Points and Creating the Calibration File .................................................... 20
    Exporting the Calibration File .................................................................................................................. 21
    Importing the Calibration Files ............................................................................................................... 22
    Verifying that Calibration was Successful .............................................................................................. 24
InView 360 HD Customer Support ............................................................................................................. 25
  Safe Fleet Community ............................................................................................................................... 25
  Contact Us .................................................................................................................................................. 25
Introduction to Calibration

The calibration process "stitches" together images from the front, back, left, and right camera views into a 360 top-level image of the space around the vehicle. After the physical installation of the cameras, ECU, antennas, push buttons, and optional monitor/recorder, the inView 360 HD AVM system will have to be calibrated to optimize this 360° view. This requires someone who is comfortable installing and configuring software. In addition to the calibration procedure, this process requires that person to do the following:

- You will need to place calibration pads so that they can be viewed without obstruction.
- You will need to “take” images via the vehicle cameras for use during calibration.
- You will need to unzip, copy, and launch the calibration tool on a PC.
- You will need to transfer image files from the inView 360 HD AVM system to your Windows PC.
- You will need to save the calibration file to the USB memory device, and upload it to the ECU.

Calibration Kit Components

1 x a set of four (4) calibration pads

1 x USB memory drive that contains the Calibration Tool. (NOTE: This memory drive can be used for transferring the camera images from/to the ECU to your PC.)

Placing Calibration Pads

Calibration pads provide reference points for the cameras during the software calibration process. Therefore, it is important that the calibration pads are accurately and optimally placed.

Using the roll of police-type tape provided with the inView 360 HD AVM system kit, create a rectangular perimeter around the vehicle, ensuring that you use perpendicular (90 degree) angles at each corner.

![TIP!]

Calibration pads need to be placed at least 20 inches away from all sides of the vehicle.

Incorrect Tape Placement

Correct Tape Placement
Correct Pad Placement

Verifying Calibration Pad Placement

Calibration pads provide reference points for the cameras during the software calibration process. Therefore, it is important that the calibration pads are accurately and optimally placed.

1. Power up the inView 360 HD AVM system.
   
   You should see the simulated 360° image on one side of the monitor, and channel 1 (front camera) on the other side.

2. Press the green DRIVER/VIEW button repeatedly until you’ve cycled through every camera view.

   While reviewing the images on the monitor, ensure that the cameras have a direct line-of-sight with the calibration pads.

   The pads should not be obstructed by mirrors, ladders, or any other protruding objects.
In this image, you can see that the calibration pad at the left is not placed correctly. It cannot be clearly seen as it is behind a door.

The calibration pads should not be obstructed by mirrors, ladders, or any other protruding objects.

3. Move the calibration pads further away from the vehicle if there is an obstruction blocking the pad in the camera's field of view.

**NOTE: Spacing the Calibration Pads**

For calibration, all four pads must be an equal distance away from the vehicle. So if you move any one calibration pad, then you must move the other three pads an equal distance away from the vehicle. See the example below.

**Trial Pad Placement**

**Optimal Pad Placement**
4. Cycle through the images again after you have adjusted the placement of the pads. Verify that the pads are visible and unobstructed.

**Poor Pad Placement**

Pad is obstructed by the vehicle door.

**Optimal Pad Placement**

Nothing obstructing either pad.
Before You Begin Calibrating

Preparing the Calibration Tool

1. Find the USB drive that was in your calibration kit (which you purchased separately).
2. Unzip and copy the .exe file to a location of your choosing on the laptop you’ll be using for the calibration procedure.
3. Double-click the .exe file to launch the calibration tool.

Transferring Image Files from the inView 360 HD System to Your Computer

To calibrate the inView 360 HD AVM system, you will need to take the images from the ECU and load them into the calibration tool on your PC. See the procedures that follow.

1) Export the inView 360 HD AVM Video Files / Logging in to the Calibration Tool

1. Use the key to remove the lock-removable front cover

2. Insert a USB drive into the USB port on the ECU.

NOTE: Replacement USB drive

Contact Technical Support if you have problems with your USB drive, which contains the Calibration tool, and which can be used to transfer images from/to the ECU.
3. Connect a USB mouse.

4. Connect a monitor via the CVBS connector.

**NOTE: About the USB Mouse**

The USB mouse does not come with the calibration kit.
5. Power up the inView 360 HD system. When the monitor turns on, you should see two images on the Live screen:
   • The 360 image on the left
   • Channel 1 (left camera) on the right

6. Use the USB mouse that you previously connected to the ECU (See "3. Connect a USB mouse," on page 8) to log into the system. Right-click anywhere on the screen, then select **Login**.

7. Select **Yes** when asked if you want to proceed with stopping the recorder.
8. Double-click in the input field to open the virtual keyboard, and then enter the default password: 88888888 (8 number eights).

If you make a mistake, click the X.

9. Click ESC or the back key when you have finished entering the default password to return to the login screen.

10. Click OK to log in.

The AVM Calibration main menu opens.
11. Click to select AVM, then select **Calibration File** in the AVM Calibration menu.

The **Calibration File Setup** window opens.

On the left side you should see 5 files:

- Camera_Left
- Camera_Right
- Camera_Front
- Camera_Back
- Calibration Configure.xml

12. Click **Export**

The files should now be exported to the USB memory device.
2) Transfer the Image Files to the PC

After you have downloaded the image files from the ECU to the USB memory device, you have to remove the USB memory device from the ECU and insert it in the PC you are using for system calibration.

3) Load the Images into the Calibration Tool

After you have inserted the USB memory device into your PC, you have to load the calibration images into the calibration tool. These images will be used to define the 360° view for the inView 360.

1. Launch the Calibration tool by finding it where you saved it on your PC, and then double-clicking or right-click>Open the .exe file. The main Result window opens.

   ![Result Window](image)

   1. Press F1 to F8 to select Calibration Point_1 to Point_8
   2. Press Up and Down Keys to switch between Calibration Point_1 to Point_8
   3. Press F9 to F12 to switch between Left/Right/Front and Back Views
   4. Press Space key to show sample calibration format or calibration grid
   5. Click the second view to change camera view
   6. Ctrl + drag the mouse to select the enlarged area

   ![Open Button](image)
2. Click **Open**. The **Unit Selection** window opens.

   ![Unit Selection](image)

   **Please select the unit type!**

   **Metric**  **Imperial**

3. Select a unit of measurement. The **Open Directory** window opens.

   ![Open Directory](image)

4. Navigate to the USB storage device.

   Export files are organized into folders arranged by date and time.

5. Select the most recent export folder, then click **Select Folder**.
If the files were loaded correctly, they will automatically populate the correct fields in the **Directory** window.

And images will appear in the **Result Window**.
Calibrating the inView 360 HD

When you have successfully loaded the calibration files, then you can proceed with the calibration. The calibration process involves entering measurements and defining areas for the calibration pads. Carefully follow the order for entering the calibration pad points.

After successfully calibrating, you will then save the calibration file and then finally load it into the ECU.

⚠️ NOTE: Using the Keyboard

From this point, you will be using your PC for the calibration procedures. So any reference to “the keyboard” means the keyboard on your PC, not the virtual keyboard within the ECU.

The Calibration Process

Carefully follow the specific order of the calibration process. The process comprises 5 steps:

1. Mark the 8 points for each of the four calibration pads (left, right, front, back). See below.
2. Click Calibrate to process the assigned calibration points and create the calibration file. See "Calibrating the Calibration Points and Creating the Calibration File" on page 20.
4. Import the calibration file into the ECU. See "Importing the Calibration Files" on page 22.
5. Verify the calibration in the ECU. See "Verifying that Calibration was Successful" on page 24.

Marking the Calibration Points

1. Click to select the AVM tab in the Calibration Tool window.
2. A Sample calibration format popup appears. It indicates the order in which you should enter the points.
3. Press the Space bar or click the X to hide this popup.
3. Enter the calibration **Length** and **Width**.

The length and width are measured from the inside edges of the calibration pads.

The values that you enter in the Length and Width fields will be in whatever unit you selected in Step 3 on page 13.
The order for entering the calibration points

The pad points must be defined in the exact order as indicated on this sample diagram.

The first camera view to be calibrated is the Left cam, which is indicated by the .jpg in the file name.

4. Ensure that Point_1 is selected from the Point drop-down menu.

5. Press CTL on your keyboard, then click and drag with your mouse to draw a box around the left pad. Letting go of the mouse will zoom in on the pad.

6. Left-click on the zoomed-in image to place an X on the top left corner to mark it Point_1.
The **Point_1** field will show Completed when you have successfully marked that point.

7. Select the next point from the **Point** drop-down menu.

OR

Use the mouse wheel to move to the next point.

8. Left-click on the next pad corner to mark the next point. The **Point_2** field will display **Completed** when you have successfully marked Point_2.

9. Click and drag with your mouse to draw a box around the right pad. Letting go of the mouse will zoom in on the pad. [*I cannot do this.*]

10. Select **Point_3** from the drop-down **Point** menu, and then left-click on the upper left corner of the right-hand calibration pad to mark it as **Point_3**.
11. Continue the process to mark Point_4, then select Point_5 from the Point drop-down menu.

12. Click the bottom right corner on the right-hand pad to mark Point_5. Then continue to the left to mark Point_6.

13. Press ESC to zoom back out. Left-click and draw a square around the left-hand pad to zoom in to mark Point_7 and Point_8.
14. Go back to the left-hand pad to mark **Point_7** and **Point_8**. Select the correct point from the Point drop-down menu, then click on the correct corners in the correct order.

15. Click to select the next image from the View drop-down menu, and then repeat the process of marking the calibration pad points.

16. Repeat the process until all 8 pad points are defined for each of the four images: left (file marked _l.jpg), right (file marked _r.jpg), front (file marked _f.jpg), and back (file marked _b.jpg).

**Calibrating the Calibration Points and Creating the Calibration File**

1. Click **Calibrate** when you have marked all pad corners for all four images.
2. Click Close if the Calibration Result window indicates that the calibration process has been successful.

Exporting the Calibration File

1. Click the File tab.
2. Click Save on the File tab. A Save As navigation window opens where you can select where to save the calibration file.
3. Navigate to the USB drive directory, then click Select Folder.

The calibration file should now be saved on your USB memory device.
Importing the Calibration Files

After you have successfully marked the pads, calibrated them, and created a calibration file, you then import that calibration file into the ECU for the ECU to use for processing the images from the four vehicle cameras.

1. Insert the USB memory device with the calibration file into the inView 360 HD AVM’s ECU.

2. Power up the inView 360 HD AVM system, which opens to the main window.
   
   You should see two images:
   
   • The 360 image on the left
   • Channel 1 (left camera) on the right

3. Use the USB mouse that you previously connected to the ECU (See “3. Connect a USB mouse.” on page 8) to log into the system. Right-click anywhere on the screen, then Login. The main menu opens.
4. Click to select AVM from the main menu.

The AVM Calibration menu opens.


6. Select from the Import File list the calibration file that you exported from your PC, then click Import to load the calibration file.

7. Click Yes on the Do you want to apply selected Calibration-Result? confirmation message.

The calibration file should upload to the ECU.
Verifying that Calibration was Successful

The final mandatory step for calibrating your inView360 HD AVM system is to ensure that the calibration file was successfully uploaded to the ECU, and that the ECU is correctly using the calibration.

1. Navigate to or back to the Live screen. If you are in any of the calibration windows, click the Back button and/or the ESC button until you see the Live screen.

   The blue arrow in the upper right corner indicates the camera view currently being shown on the monitor.
   
   • Front = ↑
   • Rear = ↓
   • Left = ←
   • Right = →

2. Use the Green Driver/View button to verify that the monitor cycles through the different camera views.
   
   a. Click the Green button to cycle through the camera views, which should follow this pattern: LEFT, RIGHT, FRONT, BACK. The BACK view should show the back-up lines.
   b. Continue to press the Green button to display the TOP and SPLIT views.
   c. If you see all 6 views while cycling, then the Green calibration was successful.

   **NOTE: The 6 views**

   Clicking the Green button cycles through the following 6 views: Top + Left, Top + Right, Top + Front, Top + Back, Full Top, and a split view that contains Left, Right, Front, and Back.

3. Use the Red Event button to ensure that Event Recording works. When you press the Red button, you should see a EVENT RECORDED message.

4. Use the Black Overlay button to ensure that the outrigger indicators (red bars on the sides of the vehicle overlay) turn off/on when you press the button.
inView 360 HD Customer Support

Safe Fleet Community

User documentation, training videos, and other technical resources for the InView 360 HD system can be found on Rear View Safety's dedicated 360 HD page:

Contact Us

Email: customerservice@rearviewsafety.com
Phone: 800-764-1028
Support Hours: Mon-Thu 9:00am-5:30pm, Fri 9:00am-5:00pm EST